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ในยคุทีเ่ทคโนโลยเีวบ็แอปพลเิคชนัมบีทบาทส าคญัในการขบัเคลื่อนนวตักรรม การเรยีนรู้การ
พฒันาเวบ็ดว้ย Java Servlet ถอืเป็นรากฐานทีม่ ัน่คงส าหรบันกัพฒันาซอฟตแ์วร์ที่ต้องการเขา้ใจระบบ
ฝัง่เซริฟ์เวอรอ์ยา่งลกึซึง้ หนงัสอืเล่มนี้จงึถูกจดัท าขึน้เพื่อเป็นแนวทางการเรยีนรู้ Java Servlet ตัง้แต่
ระดบัพื้นฐานไปจนถึงระดบั Enterprise โดยเรยีงล าดบัเนื้อหาอยา่งเป็นระบบ พรอ้มตวัอยา่งโค้ดและ
แบบฝึกหดัในแต่ละบท เพื่อใหง้่ายต่อการปฏบิตัจิรงิ 

เริม่ตน้จากการปพูืน้ฐานของ Java EE และ Servlet API เพื่อใหผู้อ่้านเขา้ใจโครงสร้างหลกัของ
เทคโนโลย ีจากนัน้พาไปรูจ้กักบัการสรา้ง Servlet แรก การท างานของ HTTP Request/Response และ 
Lifecycle ของ Servlet ต่อด้วยการผสานการท างานกบั JSP, Form Handling และ Session 
Management ซึง่เป็นหวัใจของการพฒันาเวบ็แบบไดนามกิ 

เมื่อมพีื้นฐานเพยีงพอ ผู้อ่านจะได้เรยีนรู้เทคนิคระดบักลาง เช่น การใช้ Filters, Listeners, 
การจดัการข้อผิดพลาด และระบบรกัษาความปลอดภยั (Security & Authentication) พร้อมทัง้
การเชื่อมต่อฐานขอ้มลูดว้ย JDBC และการจดัโครงสรา้งโคด้ดว้ย DAO Pattern 

ระดบัสงูขึน้ไป หนงัสอืจะพาไปรูจ้กักบัการสรา้ง RESTful API, การใช ้JSON กบั Servlet, การ
เขยีน WebSocket Application, และการพฒันาแอปพลเิคชนัแบบ Asynchronous Processing 
รวมถงึแนวทางการพฒันา Microservices ดว้ย Spring Boot และการ Deploy ระบบดว้ย Docker 
ทา้ยทีสุ่ด ผูอ่้านจะไดเ้ขา้สู่การใชง้าน Servlet ในระดบั Enterprise ดว้ยสถาปัตยกรรมแบบ MVC 
(Model-View-Controller) การใช ้CDI, JPA และ EJB ตลอดจนการท า CI/CD บน Cloud Platform 
ดว้ยเครื่องมอืสมยัใหม่อยา่ง Jenkins และ Kubernetes 

หนงัสอืเล่มนี้เหมาะส าหรบัทัง้ผูเ้ริม่ต้นทีต่อ้งการปพูืน้ฐานอยา่งมัน่คง ไปจนถงึนกัพฒันาที่
ตอ้งการยกระดบัทกัษะสู่ระดบั Enterprise โดยหวงัเป็นอยา่งยิง่วา่จะเป็นคู่มอืทีช่่วยใหผู้อ่้านสามารถน า 
Servlet ไปประยกุตใ์ชไ้ดจ้รงิในโปรเจกตข์องตนเอง และพฒันาทกัษะในสายงาน Java Web ไดอ้ยา่ง
มัน่ใจ 

“เร่ิมจากพื้นฐานอย่างมัน่คง ก้าวสู่ระดบัสงูอย่างเป็นระบบ” 
คอืแนวคดิหลกัของหนงัสอืเล่มนี้ 

ขอใหทุ้กท่านมคีวามสุขกบัการเรยีนรูแ้ละเขยีนโปรแกรมดว้ย Java Servlet อยา่งมปีระสทิธภิาพ 
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บทท่ี 1 
พื้นฐาน Java EE และ Servlet API 
(Java EE and Servlet API Basic) 

 
เน้ือหา 

 Java EE คอือะไร? 
 ความแตกต่างระหวา่ง Java SE และ Java EE 
 โครงสรา้งของ Servlet API (javax.servlet และ javax.servlet.http) 

 วธิตีดิตัง้ Servlet Container (Apache Tomcat, GlassFish) 
 

ในยุคที่ระบบเวบ็แอปพลเิคชนัมคีวามซบัซ้อนและต้องตอบสนองต่อผู้ใช้งานจ านวนมาก การ
พฒันาแอปพลเิคชนัทีม่คีวามยดืหยุน่ ปรบัขยายไดง้่าย และมโีครงสร้างชดัเจนจงึเป็นสิง่ส าคญั หนึ่งใน
เทคโนโลยทีี่ตอบโจทยน์ี้ได้อย่างดคีอื Java EE (Jakarta EE) ซึ่งเป็นแพลตฟอร์มส าหรบัพฒันาแอป
พลเิคชนัระดบัองค์กรที่มขีนาดใหญ่ โดยเฉพาะอย่างยิง่ในส่วนของการพฒันาเวบ็แอปพลเิคชนัแบบ
เซริฟ์เวอรฝั์ง่ Java ซึง่ม ีServlet API เป็นพืน้ฐานส าคญัในการควบคุมการรบั-ส่งขอ้มลูผ่าน HTTP 
Java EE (Enterprise Edition) แตกต่างจาก Java SE (Standard Edition) ตรงที่ Java EE มี
เครื่องมอืและไลบรารเีฉพาะทีอ่อกแบบมาเพื่อรองรบังานระดบัองคก์ร เช่น EJB, JPA, CDI และแน่นอน
วา่ Servlet เองกเ็ป็นหนึ่งในองค์ประกอบหลกัของ Java EE ด้วย โดย Servlet API มโีครงสร้างอยู่ใน
แพ็กเกจหลกัคือ javax.servlet และ javax.servlet.http ซึ่งให้นักพฒันาสามารถจดัการกบัค าขอ 
(request) และผลลพัธ์ (response) ได้อย่างยดืหยุ่นและเป็นระบบ ไม่ว่าจะเป็นการจดัการ session, 
cookie, การรบัค่าจากฟอรม์ หรอืแมแ้ต่การควบคุมเสน้ทาง (routing) ของแอปพลเิคชนั 

ก่อนจะเริม่เขยีนโค้ด Servlet ได้ ผู้พฒันาต้องตดิตัง้ Servlet Container หรอื Web Server ที่
รองรบั Servlet API เสยีก่อน โดยในหนงัสอืเล่มนี้จะกล่าวถึงการตดิตัง้และใช้งาน Apache Tomcat ซึ่ง
เป็น Servlet Container ยอดนิยม และ GlassFish ซึง่เป็น Application Server ทีร่องรบั Java EE อยา่ง
เต็มรูปแบบ ผู้อ่านจะได้เรยีนรู้วธิีการติดตัง้ การตัง้ค่าเบื้องต้น รวมถึงวธินี าโค้ด Servlet ไปรนัใน
สภาพแวดลอ้มจรงิ เพื่อวางรากฐานให้มัน่คงก่อนเขา้สู่การพฒันาแอปพลเิคชนัแบบเตม็รูปแบบในบท
ถดัไป 

 
พื้นฐานความเข้าใจ Java EE และ Servlet API 
� Java EE คืออะไร? 
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Java EE (Java Platform, Enterprise Edition) หรอืชือ่ใหม่วา่ Jakarta EE คอืชุดเทคโนโลยทีี่
ออกแบบมาเพื่อการพฒันา Enterprise Applications ซึง่เป็นแอปพลเิคชนัขนาดใหญ่ทีม่คีวามซบัซอ้น 
เช่น ระบบธนาคาร, ระบบโรงพยาบาล, ระบบขายสนิคา้ออนไลน์ ฯลฯ 
Java EE ประกอบดว้ย API และสเปกทีอ่อกแบบมาส าหรบั: 

 การพฒันา Web Application (Servlet, JSP) 
 การจดัการฐานขอ้มลู (JPA, JDBC) 
 การควบคุม Transaction (JTA) 
 การท า Dependency Injection (CDI) 
 การจดัการ Session และ Security 
 การใช ้EJB, JMS, Web Services ฯลฯ 

Java EE เป็นส่วนขยายของ Java SE (Standard Edition) โดยใชพ้ืน้ฐานภาษา Java เดยีวกนัแต่เพิม่
ขดีความสามารถทางฝัง่เซริฟ์เวอร์ 

 
� ความแตกต่างระหว่าง Java SE และ Java EE 

คณุสมบติั Java SE Java EE 

ขอบเขต 
ใชส้รา้งโปรแกรมทัว่ไป เช่น Desktop 
App, Console App 

ใชส้รา้งระบบฝัง่เซริฟ์เวอร ์เช่น Web App, 
Enterprise App 

API หลกั java.lang, java.util, java.io 
javax.servlet, javax.ejb, javax.persistence, 
javax.websocket 

เหมาะกบั โปรแกรมเมอรท์ ัว่ไป, นกัเรยีน นกัพฒันาเวบ็, นกัพฒันาระบบองคก์ร 

การท างาน ท างานแบบ Standalone 
ตอ้งรนัใน Application Server เช่น Tomcat, 
GlassFish 

 
� โครงสร้างของ Servlet API 
� Package หลกัใน Servlet API: 

1. javax.servlet – ใหค้ลาสพืน้ฐานของ Servlet เช่น Servlet, ServletRequest, 
ServletResponse, Filter, ServletContext 

2. javax.servlet.http – ขยายจาก javax.servlet โดยรองรบัโปรโตคอล HTTP เช่น: 
o HttpServlet 
o HttpServletRequest 
o HttpServletResponse 
o HttpSession 
o Cookie 



ศูนยห์นงัสือราคานกัเรียน 

 

Java Servlet Web Programming หนา้ 3 

 

� ตวัอย่างการใช้ HttpServlet: 
import java.io.IOException; 
import javax.servlet.*; 
import javax.servlet.http.*; 
 
public class HelloServlet extends HttpServlet { 
    @Override 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
        throws ServletException, IOException { 
        response.setContentType("text/html"); 
        response.getWriter().println("<h1>Hello from Servlet!</h1>"); 
    } 
} 
HttpServlet เป็นคลาสหลกัทีเ่ราจะสบืทอดเพื่อเขยีน Web App ฝัง่ Server 

 
วิธีติดตัง้ Servlet Container (Apache Tomcat, GlassFish) 
� 1. Apache Tomcat 
Tomcat เป็น Servlet Container ทีไ่ดร้บัความนิยมสงูสดุ และรองรบัสเปก Servlet/JSP 

 เวบ็ไซตด์าวน์โหลด: https://tomcat.apache.org/ 
 ขัน้ตอนติดตัง้: 

1. ดาวน์โหลด Apache Tomcat เวอรช์นัล่าสุด 
2. แตก zip ไฟล ์
3. รนัค าส ัง่: 
4. ./bin/startup.sh   # ส าหรบั Linux/macOS 
5. ./bin/startup.bat  # ส าหรบั Windows 
6. เขา้สู่ระบบ: http://localhost:8080 

� 2. GlassFish Server 
GlassFish เป็น Full Application Server ทีร่องรบั Java EE (Jakarta EE) ทัง้ชุด 

 เวบ็ไซตด์าวน์โหลด: https://projects.eclipse.org/projects/ee4j.glassfish 
 ขัน้ตอนติดตัง้: 

1. ดาวน์โหลด GlassFish ZIP ไฟล ์
2. แตกไฟลแ์ลว้เขา้ไปยงัโฟลเดอร ์glassfish/bin 
3. เริม่ตน้เซริฟ์เวอร:์ 
4. ./asadmin start-domain 

https://tomcat.apache.org/
http://localhost:8080/
https://projects.eclipse.org/projects/ee4j.glassfish
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5. เขา้ไปที ่http://localhost:8080 (เวบ็แอป) และ http://localhost:4848 (admin console) 
� ใช้งานร่วมกบั NetBeans 
NetBeans สามารถเชื่อมต่อกบัทัง้ Tomcat และ GlassFish ไดอ้ยา่งง่าย: 

 ไปที ่Tools > Servers > Add Server 
 เลอืกชนิดเซริฟ์เวอรท์ีต่อ้งการตดิตัง้ 
 ระบุ path ของ Tomcat หรอื GlassFish ทีต่ดิตัง้ไว ้
 เมื่อสรา้ง Project ใหม่ เลอืกชนิดวา่เป็น "Java Web with Ant" หรอื "Maven Web App" และ

ผกูกบั Server ทีต่ ัง้ไว ้

 
� สรปุ 
ในหวัขอ้นี้เราไดเ้รยีนรูว้า่: 

 Java EE คอืชุดเครื่องมอืส าหรบัพฒันาเวบ็และระบบองคก์ร 
 Java SE เหมาะกบัโปรแกรมทัว่ไป ขณะที ่Java EE เหมาะกบัระบบฝัง่ Server 
 Servlet API มโีครงสรา้งทีแ่บ่งเป็น javax.servlet และ javax.servlet.http 
 การตดิตัง้ Servlet Container อยา่ง Tomcat หรอื GlassFish เป็นขัน้ตอนเริม่ตน้ทีส่ าคญั 

 
เพ่ิมเติมเชิงลึก ส าหรบัแต่ละหวัขอ้ใน ท าความเข้าใจ Java EE และ Servlet API โดยละเอยีด พรอ้ม
ค าอธบิายเสรมิและตวัอยา่งประกอบ: 

 
� Java EE (Jakarta EE) คืออะไร? 
Java EE (หรอืชื่อใหม่วา่ Jakarta EE ตัง้แต่ปี 2019 เป็นตน้มา) คอืแพลตฟอรม์ที ่Oracle และชุมชน 
Jakarta EE พฒันาร่วมกนัเพื่อใหใ้ชส้รา้งระบบเวบ็และแอปพลเิคชนัระดบัองคก์ร ซึง่รวม: 

 Web Layer (Servlet, JSP, JSF) 
 Business Layer (EJB, CDI) 
 Persistence Layer (JPA) 
 Integration Layer (JMS, Web Services) 

� จดุเด่นของ Java EE: 
 ท างานบน Application Server ทีจ่ดัการ Lifecycle, Thread, Security ใหโ้ดยอตัโนมตั ิ
 รองรบั Dependency Injection (DI) และ MVC 
 มมีาตรฐานกลาง ท าใหโ้คด้ยา้ยไประบบอื่นไดง้่าย 

 
� ความแตกต่างระหว่าง Java SE กบั Java EE (Jakarta EE) 

หวัข้อ Java SE Java EE 

http://localhost:8080/
http://localhost:4848/
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หวัข้อ Java SE Java EE 

ใชท้ าอะไร แอปทัว่ไป: Desktop, Console Web App, ระบบองคก์ร 

API java.lang, java.io, java.util javax.servlet, javax.ejb, javax.persistence 

การจดัการ เขยีนโคด้ควบคุมเอง Managed by Container (เช่น GlassFish, Tomcat) 

สถาปัตยกรรม Standalone Client/Server หรอื Distributed 

ตวัอยา่ง โปรแกรมค านวณ, เกมเลก็ ๆ เวบ็ขายของ, ระบบบญัช,ี ระบบโรงพยาบาล 

 
� โครงสร้างของ Servlet API 
� javax.servlet: 

 Servlet: อนิเทอรเ์ฟซหลกัทีทุ่ก Servlet ตอ้ง implement 
 ServletRequest: ขอ้มลูค ารอ้งจาก client 
 ServletResponse: การตอบกลบัจาก server 
 Filter: ดกัจบั request/response ก่อน/หลงัเขา้ servlet 
 ServletContext: ขอ้มลูระดบัแอปพลเิคชนั 

� javax.servlet.http: 
 HttpServlet: คลาสพืน้ฐานทีใ่ชง้านง่ายส าหรบั HTTP 
 HttpServletRequest: รบัขอ้มลู URL, form, cookie, session 
 HttpServletResponse: สรา้ง HTML หรอื JSON ตอบกลบั 
 HttpSession: จดัการ session ของผูใ้ช ้
 Cookie: จดัการขอ้มลูฝัง่ client (จ า username ได ้ฯลฯ) 

� ตวัอย่างการใช้ HttpServletRequest: 
protected void doPost(HttpServletRequest request, HttpServletResponse response) 
        throws ServletException, IOException { 
    String username = request.getParameter("username"); 
    response.getWriter().println("Welcome, " + username); 
} 

 
� การติดตัง้ Servlet Container 
� Apache Tomcat (เหมาะส าหรบัเร่ิมต้น) 
Tomcat เป็น Web Container ทีเ่บาและนิยมมาก 
ขัน้ตอน: 

1. ดาวน์โหลดจาก https://tomcat.apache.org 

https://tomcat.apache.org/
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2. แตก zip และเขา้โฟลเดอร ์/bin 
3. รนั: 
4. startup.bat     (Windows) 
5. ./startup.sh    (Linux/macOS) 
6. เปิดเบราวเ์ซอร:์ http://localhost:8080 

✔  โฟลเดอรส์ าคญั: 
 /webapps/ – ไฟล ์.war ที ่deploy จะอยูท่ ีน่ี่ 
 /conf/ – ใชก้ าหนดค่า เช่น server.xml, web.xml 

 
� GlassFish (Full Java EE Server) 
GlassFish รองรบัทุก API ของ Java EE เช่น EJB, JPA, CDI, JMS 
ขัน้ตอน: 

1. ดาวน์โหลดจาก https://glassfish.org 
2. แตกไฟล ์แลว้เปิดเทอรม์นิลั: 
3. ./asadmin start-domain 
4. เบราวเ์ซอร:์ 

o แอป: http://localhost:8080 
o Admin Console: http://localhost:4848 

 
� เสริม: วิธี Deploy Servlet บน NetBeans (กบั Tomcat หรือ GlassFish) 

1. ติดตัง้ Server ใน NetBeans 
o Tools → Servers → Add Server 
o เลอืก Apache Tomcat หรอื GlassFish 
o ระบุ path ไปยงัโฟลเดอรท์ีต่ดิตัง้ไว ้

2. สร้างโปรเจกต ์Servlet ใหม่ 
o File > New Project > Java Web > Web Application 
o ตัง้ชื่อ > เลอืก Server > เลอืก Java EE version > Finish 

3. สร้าง Servlet 
o คลกิขวาที ่"Source Packages" → New → Servlet 
o ตัง้ชื่อเช่น HelloServlet และ URL pattern เช่น /hello 

4. เขียนโค้ด 
@WebServlet("/hello") 
public class HelloServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest req, HttpServletResponse res) 

https://glassfish.org/
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        throws ServletException, IOException { 
        res.getWriter().println("<h1>Hello World!</h1>"); 
    } 
} 

5. รนัโปรเจกต ์→ เบราวเ์ซอรจ์ะเปิดไปยงั http://localhost:8080/YourApp/hello 

 
� สรปุภาพรวม 

หวัข้อหลกั รายละเอียด 

Java EE แพลตฟอรม์ส าหรบั Web & Enterprise Apps 

Java SE vs EE EE มเีครื่องมอืจดัการฝัง่ Server 

Servlet API ม ีjavax.servlet และ javax.servlet.http 

Tomcat Web Container เบา ใชง้่าย 

GlassFish Full Java EE Server ใชใ้นองคก์รใหญ่ 

NetBeans IDE ทีผ่กูกบั Server และสรา้ง Servlet ไดง้่าย 

 
  
สรปุ 

Java EE (หรือ Jakarta EE ในปัจจบุนั) คอืแพลตฟอร์มที่พฒันาต่อยอดจาก Java SE เพื่อ
รองรบัการสรา้งแอปพลเิคชนัระดบัองคก์ร โดยเฉพาะระบบทีม่คีวามซบัซอ้น เช่น เวบ็แอปพลเิคชนัและ
ระบบกระจายศูนย ์(distributed systems) ความแตกต่างส าคญัระหว่าง Java SE และ Java EE คอื 
Java SE ให้เครื่องมือพื้นฐานส าหรบัเขยีนโปรแกรมทัว่ไป ในขณะที่ Java EE เพิม่ API และ
คอมโพเนนต์ที่ออกแบบมาเพื่อจดัการงานฝัง่เซริ์ฟเวอร์ เช่น Servlet, JSP, JPA, EJB และอื่น ๆ ซึ่ง
ช่วยใหน้กัพฒันาสามารถเขยีนแอปพลเิคชนัทีม่โีครงสรา้งชดัเจนและขยายไดง้่ายขึน้ 

หนึ่งในองค์ประกอบหลกัของ Java EE คอื Servlet API ซึ่งแบ่งออกเป็นสองแพก็เกจหลกั 
ไดแ้ก่ javax.servlet ทีใ่ชจ้ดัการกบัคอนเทนเนอรโ์ดยรวม และ javax.servlet.http ทีใ่ชจ้ดัการกบั HTTP 
Protocol โดยตรง เช่น ค าส ัง่ GET, POST, การจดัการ session และ cookie ส าหรบัการทดสอบและใช้
งาน Servlet จรงิ จ าเป็นต้องตดิตัง้ Servlet Container เช่น Apache Tomcat ซึ่งเหมาะส าหรบัการ
พฒันาและรนัแอปพลเิคชนั Servlet และ JSP เบื้องต้น หรอื GlassFish ที่รองรบั Java EE อย่าง
ครบถ้วน เหมาะส าหรบังานระดบัองค์กร การติดตัง้และตัง้ค่าเหล่านี้เป็นข ัน้ตอนพื้นฐานที่ช่วยให้
นกัพฒันาสามารถเริม่ตน้สรา้งเวบ็แอปพลเิคชนัดว้ย Java ไดอ้ยา่งมปีระสทิธภิาพ 
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บทท่ี 2 
เร่ิมต้นสร้าง Java Servlet 

(First Java Servlet) 
 

เน้ือหา 

 ตดิตัง้ NetBeans + GlassFish หรอื Tomcat 

 การเขยีน Basic Servlet (HttpServlet) 

 การก าหนดค่า URL Mapping (web.xml, @WebServlet) 
 

หลงัจากทีผู่อ่้านไดเ้รยีนรูแ้นวคดิพืน้ฐานของ Java EE และโครงสร้างของ Servlet API ไปแล้ว 
ในบทนี้เราจะเขา้สู่การปฏบิตัจิรงิ ด้วยการสร้าง Java Servlet ตวัแรกของเรา โดยเริม่จากการเตรยีม
เครื่องมอืพฒันาและสภาพแวดลอ้มใหพ้รอ้มใช้งาน ซึ่งจะช่วยให้ผู้อ่านสามารถทดสอบโค้ดและทดลอง
รนัแอปพลิเคชนัแบบไดนามิกได้อย่างราบรื่น บทนี้จะเน้นการตดิตัง้และใช้งาน NetBeans คู่กบั 
GlassFish หรอื Apache Tomcat ซึง่เป็นเครื่องมอืยอดนิยมและใชง้านไดฟ้ร ี

NetBeans IDE เป็นเครื่องมอืทีเ่หมาะส าหรบัผูเ้ริม่ตน้ เนื่องจากรองรบัการพฒันาเวบ็แอปพลเิค
ชนัดว้ย Java EE อยา่งครบถ้วน และสามารถเชื่อมต่อกบั GlassFish หรอื Tomcat ได้โดยตรงโดยไม่
ต้องตัง้ค่ามากนัก หลงัจากตดิตัง้ IDE และ Web Server เสรจ็เรยีบร้อย ผู้อ่านจะได้เรยีนรู้การสร้าง 
Project แบบ Web Application และเริม่ตน้เขยีน Servlet เบือ้งต้น ด้วยการสบืทอดคลาส HttpServlet 
ซึง่เป็นโครงสรา้งพืน้ฐานส าหรบัจดัการค าขอและการตอบกลบัผ่าน HTTP 

เนื้อหาจะเริม่จากการเขยีน Servlet ทีแ่สดงขอ้ความง่าย ๆ บนหน้าเวบ็ โดยใช้เมธอด doGet() 
ซึ่งจะถูกเรียกเมื่อมีค าขอแบบ HTTP GET เข้ามา จากนัน้จะใช้ HttpServletRequest และ 
HttpServletResponse ในการจดัการขอ้มลูเขา้-ออก และส่ง HTML กลบัไปยงัเบราวเ์ซอร์ของผู้ใช้ การ
เขา้ใจโครงสรา้งนี้จะเป็นพืน้ฐานส าคญัส าหรบัการพฒันาเวบ็แอปพลเิคชนัแบบไดนามกิต่อไปในอนาคต 

สุดทา้ย บทนี้จะอธบิายวธิกีารก าหนด URL Mapping เพื่อให้สามารถเขา้ถึง Servlet ผ่านเวบ็
เบราว์เซอร์ได้ ทัง้ในรูปแบบของการก าหนดในไฟล์ web.xml และการใช้ annotation อย่าง 
@WebServlet ซึ่งเป็นวธิทีี่สะดวกและทนัสมยักว่า การก าหนด URL Mapping อย่างถูกต้องจะท าให้
ผูใ้ชส้ามารถเรยีกใชง้าน Servlet ไดผ้่าน URL ทีช่ดัเจนและเป็นระบบ พรอ้มรองรบัการพฒันาในสเกลที่
ใหญ่ขึน้ในบทถดัไป 

 
การติดตัง้ NetBeans + GlassFish หรือ Tomcat 
✅ ขัน้ตอนท่ี 1: ดาวน์โหลด NetBeans 

 ไปที:่ https://netbeans.apache.org/download/ 

https://netbeans.apache.org/download/
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 เลอืก "Java EE" หรือ "All" bundle → ตดิตัง้ 
✅ ขัน้ตอนท่ี 2: ติดตัง้ GlassFish หรือ Tomcat 
✅ ติดตัง้ GlassFish: 

1. ไปที:่ https://projects.eclipse.org/projects/ee4j.glassfish/downloads 
2. ดาวน์โหลด → แตก zip ไวใ้นทีป่ลอดภยั 
3. ใน NetBeans: 

o เมนู Tools → Servers → Add Server 
o เลอืก GlassFish → Browse ไปยงัโฟลเดอรท์ีแ่ตก zip 

✅ หรือติดตัง้ Tomcat: 
1. ไปที:่ https://tomcat.apache.org/download-90.cgi 
2. ดาวน์โหลด → แตก zip 
3. ใน NetBeans: Tools → Servers → Add Server → เลอืก Tomcat 

 
✅ 2. การเขียน Basic Servlet (HttpServlet) 
✅ ขัน้ตอนท่ี 1: สร้างโปรเจกต ์Web Application 

1. File → New Project → Java Web → Web Application 
2. ตัง้ชื่อโปรเจกต ์เช่น MyFirstServlet 
3. เลอืก Server (Tomcat หรอื GlassFish) 
4. เลอืก Java EE 8 (หรอื Jakarta EE 10 ขึน้ไป) แลว้คลกิ Finish 

 
✅ ขัน้ตอนท่ี 2: สร้าง Servlet ใหม่ 

1. คลกิขวาที ่Source Packages → New → Servlet 
2. ตัง้ชื่อ: HelloServlet 
3. ตัง้ URL Mapping: /hello 

 
✅ โค้ดตวัอย่าง: HelloServlet.java 
import java.io.IOException; 
import javax.servlet.ServletException; 
import javax.servlet.annotation.WebServlet; 
import javax.servlet.http.HttpServlet; 
import javax.servlet.http.HttpServletRequest; 
import javax.servlet.http.HttpServletResponse; 
 

https://projects.eclipse.org/projects/ee4j.glassfish/downloads
https://tomcat.apache.org/download-90.cgi
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// ก าหนด URL Mapping ดว้ย Annotation 
@WebServlet("/hello") 
public class HelloServlet extends HttpServlet { 
     
    @Override 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws ServletException, IOException { 
         
        response.setContentType("text/html;charset=UTF-8"); 
         
        // เขยีน HTML ออกไปยงัเบราวเ์ซอร ์
        response.getWriter().println("<html><body>"); 
        response.getWriter().println("<h1>Hello from Java Servlet!</h1>"); 
        response.getWriter().println("</body></html>"); 
    } 
} 

 
✅ 3. การก าหนดค่า URL Mapping 
✅ วิธีท่ี 1: ใช้ Annotation (@WebServlet) 
เป็นวธิแีนะน า เพราะง่ายและไม่ตอ้งแกไ้ขไฟล ์web.xml 
@WebServlet("/hello") 
public class HelloServlet extends HttpServlet { ... } 
เมื่อเขา้ที ่http://localhost:8080/YourAppName/hello จะเหน็ผลลพัธ ์

 
✅ วิธีท่ี 2: ใช้ไฟล ์web.xml (ส าหรบั Java EE เวอรช์นัเก่า) 
ไฟลน์ี้อยูใ่น: Web Pages/WEB-INF/web.xml 
<web-app xmlns="http://xmlns.jcp.org/xml/ns/javaee" version="3.1"> 
    <servlet> 
        <servlet-name>HelloServlet</servlet-name> 
        <servlet-class>HelloServlet</servlet-class> 
    </servlet> 
     
    <servlet-mapping> 
        <servlet-name>HelloServlet</servlet-name> 
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        <url-pattern>/hello</url-pattern> 
    </servlet-mapping> 
</web-app> 

 
✅ ผลลพัธท่ี์ได้ 
เมื่อรนัโปรเจกตแ์ลว้เปิดเบราวเ์ซอร:์ 
http://localhost:8080/MyFirstServlet/hello 
จะเหน็ขอ้ความ: 
<h1>Hello from Java Servlet!</h1> 

 
✅ สรปุภาพรวม 

หวัข้อ รายละเอียด 

NetBeans + Server ใช ้NetBeans ร่วมกบั GlassFish หรอื Tomcat 

Basic Servlet สรา้ง class ที ่extends HttpServlet แลว้ override doGet() 

การ Mapping ก าหนด URL ดว้ย @WebServlet("/path") หรอืแกใ้น web.xml 

การใชง้าน เรยีกผ่านเบราวเ์ซอรต์าม URL Mapping ทีต่ ัง้ไว ้

 
ต่อไปนี้คอืตวัอยา่งเพิม่เตมิทีแ่สดงการ เขียน Java Servlet เบือ้งต้น อยา่งละเอยีด พรอ้มการ รบัค่า 
Form, แสดงผล HTML, และ URL Mapping ครบถ้วนครบั: 

 
✅ ตวัอย่างท่ี 1: Servlet แสดงข้อความต้อนรบัจาก Form 
✅ 1. ฟอรม์ HTML (form.html) 
<!DOCTYPE html> 
<html> 
<head> 
    <title>Welcome Form</title> 
</head> 
<body> 
    <h2>กรอกชื่อของคุณ:</h2> 
    <form action="welcome" method="POST"> 
        <input type="text" name="name" placeholder="กรอกชื่อของคุณ" required> 
        <input type="submit" value="ส่ง"> 
    </form> 
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</body> 
</html> 
วางไวใ้นโฟลเดอร ์Web Pages ใน NetBeans 

 
✅ 2. Servlet รบัค่าจากฟอรม์ (WelcomeServlet.java) 
import java.io.IOException; 
import javax.servlet.ServletException; 
import javax.servlet.annotation.WebServlet; 
import javax.servlet.http.HttpServlet; 
import javax.servlet.http.HttpServletRequest; 
import javax.servlet.http.HttpServletResponse; 
 
@WebServlet("/welcome") // URL Mapping 
public class WelcomeServlet extends HttpServlet { 
 
    @Override 
    protected void doPost(HttpServletRequest request, HttpServletResponse response) 
            throws ServletException, IOException { 
         
        // ดงึค่าชื่อจากฟอรม์ 
        String name = request.getParameter("name"); 
 
        // ตัง้ค่า content type 
        response.setContentType("text/html;charset=UTF-8"); 
 
        // แสดงผล HTML ตอบกลบั 
        response.getWriter().println("<html><body>"); 
        response.getWriter().println("<h1>สวสัดคีุณ " + name + "!</h1>"); 
        response.getWriter().println("</body></html>"); 
    } 
} 

 
✅ 3. การรนัโปรแกรม 

1. รนัโปรเจกตใ์น NetBeans 
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2. เปิดเบราวเ์ซอรไ์ปที:่ 
http://localhost:8080/YourProjectName/form.html 

3. พมิพช์ื่อ → คลกิ "สง่" → ระบบจะแสดงขอ้ความ: 
สวสัดคีุณ สมชาย! 

 
✅ ตวัอย่างท่ี 2: การใช้ web.xml แทน Annotation 
หากคุณไม่ตอ้งการใช ้@WebServlet ใหใ้ชไ้ฟล ์web.xml ดงันี้: 
✅ web.xml 
<web-app xmlns="http://xmlns.jcp.org/xml/ns/javaee" version="3.1"> 
    <servlet> 
        <servlet-name>WelcomeServlet</servlet-name> 
        <servlet-class>WelcomeServlet</servlet-class> 
    </servlet> 
    <servlet-mapping> 
        <servlet-name>WelcomeServlet</servlet-name> 
        <url-pattern>/welcome</url-pattern> 
    </servlet-mapping> 
</web-app> 
หมายเหต:ุ ถ้าใช ้web.xml อยา่ใส่ @WebServlet ซ ้าในคลาส 

 
✅ ตวัอย่างท่ี 3: สร้าง Servlet ท่ีแสดงวนัและเวลา 
import java.io.IOException; 
import java.time.LocalDateTime; 
import javax.servlet.ServletException; 
import javax.servlet.annotation.WebServlet; 
import javax.servlet.http.*; 
 
@WebServlet("/time") 
public class TimeServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
        throws ServletException, IOException { 
 
        LocalDateTime now = LocalDateTime.now(); 
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        response.setContentType("text/html;charset=UTF-8"); 
        response.getWriter().println("<html><body>"); 
        response.getWriter().println("<h2>เวลาปัจจุบนัคอื: " + now + "</h2>"); 
        response.getWriter().println("</body></html>"); 
    } 
} 
เปิดที:่ 
http://localhost:8080/YourProjectName/time 

 
✅ สรปุความเข้าใจเพ่ิมเติม 

 

 
หากตอ้งการ: 

 � ไฟลโ์ปรเจกต ์NetBeans ตวัอยา่ง (พรอ้ม .zip) 
 � การรบัค่า GET/POST หลายฟิลด ์(name, email ฯลฯ) 
 � การเขยีน Servlet เชื่อมต่อฐานขอ้มลู (MySQL) 
 � ตวัอยา่ง Login + Session ดว้ย Servlet + JSP 

 
ตวัอย่าง Java Servlet เพิม่เตมิอกี 5 ตวัอยา่ง พรอ้มค าอธบิายเพื่อใหเ้ขา้ใจไดง้่าย: 

 
ตวัอย่าง 1: Servlet แสดงข้อความ "Hello World" แบบง่ายสดุ 
import java.io.IOException; 
import javax.servlet.ServletException; 
import javax.servlet.annotation.WebServlet; 
import javax.servlet.http.*; 
 
@WebServlet("/hello") 
public class HelloWorldServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 

ส่ิงท่ีเรยีนรู ้ รายละเอียด 

HTML Form → Servlet รบัค่า input จากผูใ้ชผ้่าน POST 

@WebServlet ใชก้ าหนด URL Path แบบ Annotation 

request.getParameter() ดงึค่าทีผู่ใ้ชก้รอกจากฟอรม์ 

การแสดงผล HTML ใช ้response.getWriter().println() 
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            throws ServletException, IOException { 
        response.setContentType("text/html;charset=UTF-8"); 
        response.getWriter().println("<h1>Hello World from Servlet!</h1>"); 
    } 
} 
เรยีกใชง้านที ่URL: /hello 

 
ตวัอย่าง 2: Servlet รบัค่าพารามิเตอรแ์บบ GET แล้วแสดงผล 
@WebServlet("/greet") 
public class GreetingServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws ServletException, IOException { 
        String user = request.getParameter("user"); 
        if (user == null || user.isEmpty()) { 
            user = "Guest"; 
        } 
        response.setContentType("text/html;charset=UTF-8"); 
        response.getWriter().println("<h2>สวสัด,ี " + user + "!</h2>"); 
    } 
} 
เรยีกใชง้าน เช่น: 
http://localhost:8080/YourProject/greet?user=Somchai 

 
ตวัอย่าง 3: Servlet ส่ง Redirect ไปยงั URL อ่ืน 
@WebServlet("/redirect") 
public class RedirectServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        // ส่งไปยงั Google 
        response.sendRedirect("https://www.google.com"); 
    } 
} 
เรยีก /redirect แลว้จะถูกส่งต่อไปยงั Google โดยอตัโนมตั ิ
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ตวัอย่าง 4: Servlet ส่ง Forward ไปยงั JSP 
@WebServlet("/forward") 
public class ForwardServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws ServletException, IOException { 
        request.setAttribute("message", "ขอ้ความจาก Servlet ส่งไป JSP"); 
        // ส่งต่อไป JSP ทีอ่ยูใ่น /WEB-INF/view/message.jsp 
        request.getRequestDispatcher("/WEB-INF/view/message.jsp").forward(request, response); 
    } 
} 
message.jsp: 
<html> 
<body> 
    <h2>ขอ้ความทีไ่ดร้บั: ${message}</h2> 
</body> 
</html> 

 
ตวัอย่าง 5: Servlet สร้างและอ่าน Cookie 
@WebServlet("/cookie") 
public class CookieServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        // สรา้ง cookie ชื่อ user ชื่อ Somchai 
        Cookie cookie = new Cookie("user", "Somchai"); 
        cookie.setMaxAge(24 * 60 * 60); // อาย ุ1 วนั 
        response.addCookie(cookie); 
 
        // อ่าน cookie ทัง้หมด 
        Cookie[] cookies = request.getCookies(); 
        response.setContentType("text/html;charset=UTF-8"); 
        response.getWriter().println("<h3>Cookie ทัง้หมด:</h3>"); 
        if (cookies != null) { 
            for (Cookie c : cookies) { 
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                response.getWriter().println("Name: " + c.getName() + ", Value: " + c.getValue() + 
"<br>"); 
            } 
        } else { 
            response.getWriter().println("ไม่พบ cookie ใดๆ"); 
        } 
    } 
} 

 
สรปุ 

ตวัอย่าง ฟีเจอรท่ี์แสดง 

1 Servlet พืน้ฐาน แสดงขอ้ความ HTML 

2 รบัค่าพารามเิตอรผ์่าน URL (GET) 

3 Redirect ไป URL อื่น 

4 Forward ไป JSP พรอ้มสง่ขอ้มลู 

5 สรา้งและอ่าน Cookie 

 
สรปุ 

บทนี้น าเสนอขัน้ตอนการสร้าง Java Servlet แรก โดยเริม่จากการตดิตัง้เครื่องมอืที่จ าเป็น 
ได้แก่ NetBeans IDE ซึ่งเป็นเครื่องมอืส าหรบัพฒันา Java ที่รองรบัการสร้าง Web Application ได้
อยา่งสะดวก และ GlassFish หรอื Tomcat ซึ่งท าหน้าที่เป็น Servlet Container ส าหรบัรนัแอปพลเิค
ชนั โดยผูอ่้านสามารถเลอืกตดิตัง้ใหเ้หมาะสมกบัความตอ้งการและสภาพแวดลอ้มของตน 

จากนัน้จะเขา้สู่การเขยีน Servlet เบือ้งตน้โดยใช้คลาส HttpServlet ซึ่งรองรบัการรบัค าขอและ
ส่งผลลพัธ์ผ่านโปรโตคอล HTTP พร้อมอธบิายการก าหนดเส้นทาง (URL Mapping) ให้กบั Servlet 
เพื่อให้สามารถเขา้ถึงผ่านเวบ็เบราวเ์ซอร์ได้ ทัง้ในรูปแบบเดมิผ่านไฟล์ web.xml และแบบใหม่ด้วย 
annotation @WebServlet ซึง่ช่วยใหก้ารก าหนดค่าเป็นไปอยา่งยดืหยุน่และสะดวกมากขึน้ 
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บทท่ี 3 
การท างานของ HTTP และ Servlet Lifecycle 

(HTTP and Servlet Lifecycle) 
 

เน้ือหา 

 HTTP Request & Response (HttpServletRequest, HttpServletResponse) 
 Servlet Lifecycle (init(), service(), destroy()) 
 การส่งพารามเิตอรผ์่าน URL (request.getParameter()) 

 
การพฒันาเวบ็แอปพลเิคชนัด้วย Java Servlet จ าเป็นต้องมคีวามเขา้ใจเชงิลึกเกี่ยวกบัการ

ท างานของโปรโตคอล HTTP ซึ่งเป็นมาตรฐานพื้นฐานในการสื่อสารระหว่างฝัง่ผู้ใช้ (Client) และฝัง่
เซริฟ์เวอร์ (Server) โดยเฉพาะอย่างยิง่ กลไกการรบัและส่งขอ้มูลผ่านค าขอ (Request) และการตอบ
กลบั (Response) มคีวามส าคญัต่อการประมวลผลขอ้มูลของผู้ใช้ เช่น การส่งค่าผ่านแบบฟอร์ม การ
คลิกลิงก์ หรือการร้องขอบริการจากเว็บแอปพลิเคชัน คลาส  HttpServletRequest และ 
HttpServletResponse ใน Java EE จงึเป็นเครื่องมอืหลกัทีใ่ชใ้นการจดัการกบัขอ้มลูดงักล่าว 

ในบทนี้จะเริม่ตน้ดว้ยการศกึษารปูแบบและหน้าที่ของ HTTP Request และ HTTP Response 
ผ่านการ ใช้ง าน  HttpServletRequest ส าหรับการดึงค่ าพารามิเตอร์จากค าขอ และ 
HttpServletResponse ส าหรบัการจดัเตรยีมขอ้มูลตอบกลบัไปยงัเบราวเ์ซอร์ของผู้ใช้ ความเขา้ใจใน
กลไกของวตัถุทัง้สองนี้จะเอื้อต่อการเขยีนโปรแกรมที่สามารถจดัการข้อมูลระหว่างฝัง่ผู้ใช้และฝัง่
เซิร์ฟเวอร์ได้อย่างมปีระสทิธภิาพ และสอดคล้องกบัมาตรฐานของการพฒันาเวบ็แอปพลิเคชนัแบบ
สมยัใหม่ 

จากนัน้บทนี้จะน าเสนอแนวคดิของ วงจรชีวิตของ Servlet (Servlet Lifecycle) ซึ่งเป็น
โครงสรา้งพืน้ฐานทีค่วบคุมล าดบัการท างานของ Servlet ภายใตก้ารจดัการของ Servlet Container โดย
จะกล่าวถึงเมธอดหลกั ได้แก่ init() ส าหรบัการเตรยีมความพร้อมของ Servlet เมื่อถูกโหลดเขา้สู่
หน่วยความจ า service() ส าหรบัการจดัการค าขอที่เขา้มา และ destroy() ส าหรบัการคนืทรพัยากรเมื่อ 
Servlet ไม่ถูกใชง้านอกีต่อไป ความเขา้ใจในวงจรชวีตินี้มคีวามส าคญัอย่างยิง่ในการเขยีนโปรแกรมให้
สามารถจดัการทรพัยากรไดอ้ยา่งเหมาะสมและมปีระสทิธภิาพสงูสุด 

ท้ายที่สุด บทนี้จะกล่าวถึงการส่งข้อมูลจากฝัง่ผู้ใช้มายงัเซิร์ฟเวอร์ผ่าน URL โดยอาศัย
พารามิเตอร์ในรูปแบบของ Query String พร้อมแสดงตวัอย่างการใช้งานเมธอด getParameter() 
ส าหรบัดงึค่าพารามเิตอร์จากค าขอ ซึ่งเป็นเทคนิคที่ใช้กนัอย่างแพร่หลายในระบบที่รบัขอ้มูลจากผู้ใช ้
เช่น ระบบเข้าสู่ระบบ การค านวณผลลพัธ์ หรือระบบแสดงผลแบบไดนามิก ความสามารถในการ
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ประยกุตใ์ชเ้มธอดดงักล่าวจะเป็นรากฐานส าคญัของการพฒันาเวบ็แอปพลเิคชนัแบบโต้ตอบในระดบัสูง
ต่อไป 

การท างานของ HTTP และ Servlet Lifecycle 

 
1. HTTP Request & Response (HttpServletRequest, HttpServletResponse) 
HTTP คืออะไร? 

 HTTP (HyperText Transfer Protocol) คอืโปรโตคอลทีใ่ชส้ าหรบัสื่อสารขอ้มลูระหวา่งเวบ็เบรา
เซอร ์(client) และเวบ็เซริฟ์เวอร ์(server) เช่น การสง่ค าขอ (Request) เพื่อขอขอ้มลู หรอืส่ง
ขอ้มลูจากฟอรม์ แลว้เซริฟ์เวอรจ์ะตอบกลบั (Response) ดว้ยขอ้มลูทีต่อ้งการ เช่น หน้าเวบ็ 
หรอืขอ้มลู JSON 

ใน Java Servlet 
 คลาส HttpServletRequest ใชเ้พื่อเกบ็ขอ้มลูค าขอ HTTP ทีส่่งมาจากผูใ้ช ้เชน่ ขอ้มลู

พารามเิตอร,์ header, cookie ฯลฯ 
 คลาส HttpServletResponse ใชส้ าหรบัจดัการกบัการตอบกลบั HTTP เช่น ก าหนด Content-

Type, ส่งขอ้มลูกลบั, ตัง้สถานะของ HTTP Response 
ตวัอย่างการใช้ HttpServletRequest และ HttpServletResponse 
@WebServlet("/hello") 
public class HelloServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        // อ่านพารามเิตอร ์"name" ทีส่ง่มาทาง URL เช่น ?name=Somchai 
        String name = request.getParameter("name"); 
        if (name == null || name.isEmpty()) { 
            name = "Guest"; 
        } 
 
        // ก าหนด Content-Type ของการตอบกลบัเป็น text/html และ charset UTF-8 
        response.setContentType("text/html;charset=UTF-8"); 
 
        // เขยีนขอ้มลูตอบกลบัไปยงั client 
        response.getWriter().println("<h1>สวสัด ี" + name + "!</h1>"); 
    } 
} 
เมื่อเรยีก 
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http://localhost:8080/YourApp/hello?name=Somchai 
จะได ้
<h1>สวสัด ีSomchai!</h1> 

 
2. Servlet Lifecycle (init(), service(), destroy()) 
Servlet ม ีวงจรชีวิต (Lifecycle) ทีค่วรเขา้ใจ เพื่อบรหิารการท างานอยา่งถูกตอ้ง: 

Method ค าอธิบาย 

init() 
เรยีกครัง้เดยีวตอน Servlet ถูกโหลดและสรา้งขึน้ใน Servlet Container (เช่น 
Tomcat) 

service() 
เรยีกทุกครัง้ทีม่ ีHTTP Request มายงั Servlet เพื่อประมวลผลค าขอและส่ง 
Response 

doGet() / 
doPost() 

โดยทัว่ไป service() จะเรยีกเมธอดตาม HTTP Method เช่น doGet(), doPost() 

destroy() 
เรยีกครัง้เดยีวก่อน Servlet ถูกท าลาย (เช่น ตอน Server ปิดหรอื Redeploy) เพื่อ
เคลยีร ์resource 

ภาพรวมวงจรชีวิต Servlet 
1. โหลดและสร้าง Servlet (init()) 
2. รบัค าขอและประมวลผล (service() -> doGet()/doPost()) 
3. ถกูท าลาย เมื่อไม่ใชง้าน (destroy()) 

ตวัอย่าง Servlet ท่ีแสดง Lifecycle 
@WebServlet("/lifecycle") 
public class LifecycleServlet extends HttpServlet { 
 
    @Override 
    public void init() throws ServletException { 
        System.out.println("Servlet ก าลงัถูกสรา้งและ init()"); 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        System.out.println("Servlet ก าลงัประมวลผล doGet()"); 
        response.setContentType("text/plain"); 
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        response.getWriter().println("Hello from doGet()"); 
    } 
 
    @Override 
    public void destroy() { 
        System.out.println("Servlet ก าลงัถูกท าลาย destroy()"); 
    } 
} 
เมื่อ Deploy และเรยีก URL /lifecycle จะเหน็ขอ้ความใน Console วา่มกีารเรยีก init() และ doGet() 
ตามล าดบั 

 
3. การส่งพารามิเตอรผ่์าน URL (request.getParameter()) 
วธิสี่งขอ้มลูจาก Client ไปยงั Servlet ท าไดห้ลายแบบ โดยแบบหนึ่งทีง่่ายคอื ส่งผ่าน URL Query 
String 
ตวัอยา่ง URL: 
http://localhost:8080/app/hello?name=Somchai&age=30 
ใน Servlet เราสามารถดงึค่าพารามเิตอรไ์ดด้ว้ย 
String name = request.getParameter("name");  // "Somchai" 
String age = request.getParameter("age");    // "30" 
ข้อควรระวงั: 

 พารามเิตอรท์ ัง้หมดจะถูกส่งเป็น String 
 หากพารามเิตอรไ์ม่ถูกส่งมา จะไดค้่า null 
 ตอ้งเชค็ค่า null ก่อนใชง้านหรอืแปลงประเภทขอ้มลู (เชน่ String เป็น int) 

 
ตวัอย่างเตม็: รบัพารามิเตอรจ์าก URL แล้วแสดงผล 
@WebServlet("/userinfo") 
public class UserInfoServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        String name = request.getParameter("name"); 
        String ageStr = request.getParameter("age"); 
        int age = 0; 
        if (ageStr != null) { 
            try { 
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                age = Integer.parseInt(ageStr); 
            } catch (NumberFormatException e) { 
                age = -1; // ก าหนดค่าไม่ถูกตอ้ง 
            } 
        } 
 
        response.setContentType("text/html;charset=UTF-8"); 
        response.getWriter().println("<h2>ขอ้มลูผูใ้ช<้/h2>"); 
        response.getWriter().println("ชื่อ: " + (name != null ? name : "ไม่ระบุ") + "<br>"); 
        response.getWriter().println("อาย:ุ " + (age > 0 ? age : "ไม่ระบุหรอืไม่ถูกตอ้ง") + "<br>"); 
    } 
} 

 
สรปุ 

หวัข้อ ค าอธิบายสัน้ๆ 

HTTP Request & 
Response 

ใช ้HttpServletRequest อ่านขอ้มลู, HttpServletResponse ส่งขอ้มลูกลบั 

Servlet Lifecycle 
ม ี3 เมธอดหลกั: init() (เริม่ตน้), service() (ประมวลผลค าขอ), destroy() 
(ท าลาย) 

การส่งพารามเิตอรผ์่าน 
URL 

ใช ้request.getParameter("name") เพื่อดงึค่าทีส่่งมาทาง URL 

 
รายละเอยีดเพิม่เตมิในแต่ละหวัขอ้ทีเ่กีย่วกบั HTTP และ Servlet Lifecycle พรอ้มเทคนิคและแนวทาง
ใชง้านจรงิ 

 
HTTP Request & Response (เพ่ิมเติม) 
HTTP Request Methods ท่ีพบบ่อยใน Servlet 

 GET: ขอขอ้มลูจากเซริฟ์เวอร ์ส่งพารามเิตอรผ์่าน URL (Query String) เช่น ?name=abc 
 POST: ส่งขอ้มลูจาก client ไปยงั server ผ่าน body ของ HTTP request (เหมาะกบัขอ้มลู

ขนาดใหญ่ หรอืขอ้มลูทีต่อ้งการความปลอดภยักวา่) 
 PUT, DELETE, HEAD, OPTIONS: ใชใ้น REST API และ HTTP ข ัน้สงู 

การดึงข้อมลู Request Header 
เราสามารถดงึขอ้มลูส่วน header ที ่client ส่งมาดว้ยได ้เช่น 
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String userAgent = request.getHeader("User-Agent"); 
String referer = request.getHeader("Referer"); 
การตัง้ค่า Response Header และ Status Code 
response.setStatus(HttpServletResponse.SC_NOT_FOUND); // ก าหนด HTTP Status 404 
response.setHeader("Cache-Control", "no-cache"); 

 
Servlet Lifecycle (เพ่ิมเติม) 
การควบคมุการโหลด Servlet 
ในไฟล ์web.xml สามารถก าหนดให ้Servlet โหลดทนัทตีอน Server Startup ดว้ย <load-on-startup> 
<servlet> 
    <servlet-name>MyServlet</servlet-name> 
    <servlet-class>com.example.MyServlet</servlet-class> 
    <load-on-startup>1</load-on-startup> <!-- โหลดตอนเริม่เซริฟ์เวอร ์--> 
</servlet> 
สรปุภาพวงจรชีวิตแบบละเอียด 

ระยะ อธิบาย 

โหลดคลาส 
Servlet 

Container โหลดคลาส Servlet ครัง้แรกเมื่อมคี าขอหรอืถูกก าหนดใหโ้หลดตอน 
startup 

init() เรยีกครัง้เดยีว ใชส้ าหรบัตัง้ค่าเริม่ตน้ เชน่ เปิด connection, resource ต่าง ๆ 

service() เรยีกเมื่อมคี าขอ HTTP เขา้มา ท าหน้าทีส่่งต่อไปยงั doGet(), doPost(), ฯลฯ 

doGet(), doPost() แยกการท างานตามประเภท HTTP request (GET, POST) 

destroy() เรยีกเมื่อ Servlet ถูกท าลาย ใชปิ้ด resource, connection ใหเ้รยีบรอ้ย 

 
3.3 การส่งพารามิเตอรผ่์าน URL (เพ่ิมเติม) 
ส่งพารามิเตอรแ์บบ POST (Form Data) 
ส าหรบัการสง่ขอ้มลูผ่าน <form method="POST"> ตวั Servlet สามารถอ่านค่าพารามเิตอรไ์ด้
เช่นเดยีวกบั GET 
<form action="/yourapp/submit" method="POST"> 
    ชื่อ: <input type="text" name="username"> 
    <input type="submit" value="ส่ง"> 
</form> 
Servlet 
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protected void doPost(HttpServletRequest request, HttpServletResponse response) 
        throws IOException { 
    String username = request.getParameter("username"); 
    response.getWriter().println("คุณส่งชื่อ: " + username); 
} 
ส่งหลายค่าพารามิเตอรช่ื์อเดียวกนั 
กรณ ี<select multiple> หรอื checkbox ทีช่ ื่อเดยีวกนัหลายค่า เราใช ้
String[] values = request.getParameterValues("checkboxName"); 
if(values != null) { 
    for(String val : values) { 
        response.getWriter().println(val + "<br>"); 
    } 
} 

 
เทคนิคท่ีช่วยพฒันา Servlet ให้ดีขึ้น 

 Encoding: ก าหนด character encoding ก่อนอ่านค่าพารามเิตอรเ์สมอ เพื่อป้องกนัปัญหาเรื่อง
ภาษาไทยหรอื Unicode 

request.setCharacterEncoding("UTF-8"); 
 Handling null: ตรวจสอบค่าทีไ่ดจ้าก getParameter() วา่ไม่ใช่ null ก่อนใชง้าน เพื่อป้องกนั 

NullPointerException 
 Response Buffering: ตัง้ buffer ขนาดทีเ่หมาะสมเพื่อเพิม่ประสทิธภิาพการส่งขอ้มลูกลบั 

client 
 Log Lifecycle Event: การใช ้logger ใน init(), service(), destroy() จะช่วยตรวจสอบ

พฤตกิรรมของ Servlet ในการพฒันาและดบีกั 

 
ตวัอย่าง Servlet ท่ีใช้งานครบวงจร 
@WebServlet("/process") 
public class ProcessServlet extends HttpServlet { 
    @Override 
    public void init() { 
        System.out.println("Servlet init()"); 
    } 
 
    @Override 
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    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        processRequest(request, response); 
    } 
 
    @Override 
    protected void doPost(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        processRequest(request, response); 
    } 
 
    private void processRequest(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        request.setCharacterEncoding("UTF-8"); 
        String action = request.getParameter("action"); 
        response.setContentType("text/html;charset=UTF-8"); 
 
        if (action == null) { 
            response.getWriter().println("ไม่พบค าส ัง่"); 
        } else if (action.equals("hello")) { 
            response.getWriter().println("<h1>สวสัด ีServlet!</h1>"); 
        } else { 
            response.getWriter().println("ค าส ัง่ไม่รูจ้กั: " + action); 
        } 
    } 
 
    @Override 
    public void destroy() { 
        System.out.println("Servlet destroy()"); 
    } 
} 

 
HTTP Request & Response ใน Java Servlet 
1. HTTP Request (HttpServletRequest) 
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HttpServletRequest คอืออ็บเจก็ตท์ีเ่กบ็ขอ้มลูทัง้หมดของค าขอ (Request) ที ่Client ส่งมายงั Server 
ผ่านโปรโตคอล HTTP โดย Servlet จะใช ้HttpServletRequest เพื่อดงึขอ้มลูต่าง ๆ เช่น 

 URL ทีถู่กเรยีก 
 HTTP Method (GET, POST, PUT, DELETE ฯลฯ) 
 พารามเิตอรท์ีส่่งมาจาก Client (เช่น ค่าจากฟอรม์) 
 ขอ้มลู Header ต่าง ๆ (เช่น User-Agent, Cookie) 
 ขอ้มลู Session 

 
ตวัอย่างเมธอดหลกัใน HttpServletRequest 

เมธอด ค าอธิบาย ตวัอย่างการใช้งาน 

getMethod() ดงึ HTTP Method เช่น "GET", "POST" request.getMethod(); 

getParameter(String) ดงึค่าพารามเิตอรท์ีส่่งมา request.getParameter("name"); 

getHeader(String) ดงึขอ้มลู Header จาก Request request.getHeader("User-Agent"); 

getSession() ดงึ HttpSession ปัจจุบนั (หรอืสรา้งใหม่) request.getSession(); 

getRequestURI() ดงึ URI ของค าขอ request.getRequestURI(); 

 
2. HTTP Response (HttpServletResponse) 
HttpServletResponse คอืออ็บเจก็ตท์ีใ่ชใ้นการส่งขอ้มลูตอบกลบั (Response) จาก Servlet ไปยงั 
Client ผ่าน HTTP โดย Servlet จะใช ้HttpServletResponse เพื่อ 

 ก าหนดสถานะของ HTTP Response (เช่น 200 OK, 404 Not Found) 
 ก าหนด Content Type ของขอ้มลูทีต่อบกลบั (เช่น text/html, application/json) 
 เขยีนขอ้มลูออกไปยงั Client (เช่น HTML, JSON) 
 ตัง้ค่า Header ของ HTTP Response (เช่น cookie, cache control) 

 
ตวัอย่างเมธอดหลกัใน HttpServletResponse 

เมธอด ค าอธิบาย ตวัอย่างการใช้งาน 

setContentType(String
) 

ก าหนด
ประเภท
เนื้อหาที่
ตอบกลบั 

response.setContentType("text/html"); 

setStatus(int) 
ก าหนด
รหสั

response.setStatus(HttpServletResponse.SC_NOT_FOUND)
; 
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เมธอด ค าอธิบาย ตวัอย่างการใช้งาน 

สถานะ 
HTTP เช่น 
200, 404 

getWriter() 

ดงึ 
PrintWrite
r ส าหรบั
เขยีน
ขอ้ความ 

response.getWriter().println("Hello World"); 

addHeader(String, 
String) 

เพิม่ 
Header 
ให ้
Response 

response.addHeader("Cache-Control", "no-cache"); 

 
ตวัอย่างการใช้งาน HttpServletRequest และ HttpServletResponse 
นี่คอืตวัอยา่ง Servlet ง่าย ๆ ทีแ่สดงการรบัค่าพารามเิตอรจ์าก Request และตอบกลบั HTML ไปยงั 
Client 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
import java.io.IOException; 
import java.io.PrintWriter; 
 
@WebServlet("/greet") 
public class GreetingServlet extends HttpServlet { 
    @Override 
    protected void doGet(HttpServletRequest request, HttpServletResponse response)  
            throws ServletException, IOException { 
         
        // 1. อ่านค่าพารามเิตอรช์ื่อ "name" ทีส่่งมาจาก URL เช่น /greet?name=John 
        String name = request.getParameter("name"); 
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        if (name == null || name.isEmpty()) { 
            name = "Guest"; 
        } 
         
        // 2. ก าหนดประเภทเนื้อหาทีต่อบกลบัเป็น HTML 
        response.setContentType("text/html;charset=UTF-8"); 
         
        // 3. เขยีนขอ้ความตอบกลบัไปยงั Client 
        PrintWriter out = response.getWriter(); 
        out.println("<html>"); 
        out.println("<head><title>Greeting Page</title></head>"); 
        out.println("<body>"); 
        out.println("<h1>สวสัด,ี " + name + "!</h1>"); 
        out.println("</body>"); 
        out.println("</html>"); 
    } 
} 
การทดสอบ 

 เรยีก URL: http://localhost:8080/yourapp/greet?name=John 
 Servlet จะอ่านพารามเิตอร ์name จาก URL ("John") 
 ตอบกลบัหน้าจอ HTML ทีแ่สดงขอ้ความ "สวสัดี, John!" 

 
ตวัอย่างการใช้งาน Request Header และ Response Header 
@Override 
protected void doGet(HttpServletRequest request, HttpServletResponse response) 
        throws ServletException, IOException { 
     
    // อ่าน User-Agent Header จาก Client 
    String userAgent = request.getHeader("User-Agent"); 
     
    // ก าหนด Content Type 
    response.setContentType("text/plain;charset=UTF-8"); 
     
    // เพิม่ Custom Header ใน Response 
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    response.setHeader("X-Custom-Header", "MyHeaderValue"); 
     
    PrintWriter out = response.getWriter(); 
    out.println("User-Agent ทีส่่งมาคอื: " + userAgent); 
    out.println("Header X-Custom-Header ถูกตัง้ค่าแลว้"); 
} 

 
สรปุ 

ประเภท ใช้ท าอะไร ตวัอย่างการใช้งาน 

HttpServletRequest 
รบัขอ้มลูจาก Client เช่น พารามเิตอร์
, Header, Session 

getParameter(), getHeader(), 
getSession() 

HttpServletResponse 
ส่งขอ้มลูตอบกลบั Client เช่น HTML, 
JSON, Header, Status 

setContentType(), getWriter(), 
setStatus(), addHeader() 

 
ตวัอยา่ง Servlet เพิม่เตมิอกี 5 ตวัอย่าง ทีแ่สดงการใชง้าน HttpServletRequest และ 
HttpServletResponse ในรปูแบบต่าง ๆ  

 
ตวัอย่างท่ี 1: รบัค่าจากฟอรม์ (POST Method) แล้วแสดงผล 
@WebServlet("/submitForm") 
public class FormServlet extends HttpServlet { 
    @Override 
    protected void doPost(HttpServletRequest request, HttpServletResponse response) 
            throws ServletException, IOException { 
        String username = request.getParameter("username"); 
        String email = request.getParameter("email"); 
         
        response.setContentType("text/html;charset=UTF-8"); 
        PrintWriter out = response.getWriter(); 
         
        out.println("<html><body>"); 
        out.println("<h2>ขอ้มลูทีส่่งมา</h2>"); 
        out.println("ชื่อผูใ้ช:้ " + username + "<br>"); 
        out.println("อเีมล: " + email); 
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        out.println("</body></html>"); 
    } 
} 

 
ตวัอย่างท่ี 2: ตัง้สถานะ HTTP Response (404 Not Found) 
@WebServlet("/notFoundExample") 
public class NotFoundServlet extends HttpServlet { 
    @Override 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws ServletException, IOException { 
        response.setStatus(HttpServletResponse.SC_NOT_FOUND); 
        response.setContentType("text/plain;charset=UTF-8"); 
        response.getWriter().println("404 - ไม่พบหน้าเวบ็นี้"); 
    } 
} 

 
ตวัอย่างท่ี 3: อ่านและแสดงข้อมลู Header จาก Request 
@WebServlet("/showHeaders") 
public class HeaderServlet extends HttpServlet { 
    @Override 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws ServletException, IOException { 
        response.setContentType("text/plain;charset=UTF-8"); 
        PrintWriter out = response.getWriter(); 
         
        out.println("User-Agent: " + request.getHeader("User-Agent")); 
        out.println("Accept-Language: " + request.getHeader("Accept-Language")); 
    } 
} 

 
ตวัอย่างท่ี 4: ส่ง Redirect ไปยงั URL อ่ืน 
@WebServlet("/redirectExample") 
public class RedirectServlet extends HttpServlet { 
    @Override 
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    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        // Redirect ไปยงั Google 
        response.sendRedirect("https://www.google.com"); 
    } 
} 

 
ตวัอย่างท่ี 5: ตัง้ค่า Cookie ใน Response 
import jakarta.servlet.http.Cookie; 
 
@WebServlet("/setCookie") 
public class CookieServlet extends HttpServlet { 
    @Override 
    protected void doGet(HttpServletRequest request, HttpServletResponse response) 
            throws IOException { 
        Cookie cookie = new Cookie("user", "ChatGPT"); 
        cookie.setMaxAge(60*60);  // เกบ็ cookie ไว ้1 ชัว่โมง 
        response.addCookie(cookie); 
         
        response.setContentType("text/plain;charset=UTF-8"); 
        response.getWriter().println("Cookie 'user' ถูกตัง้ค่าแลว้"); 
    } 
} 

 
Servlet Lifecycle คืออะไร? 
Servlet Lifecycle คอืชุดข ัน้ตอนที ่Servlet ผ่านตัง้แต่ 

1. ถูกสรา้งและเริม่ตน้ (init) 
2. รบัและตอบสนองค าขอ (service) 
3. ถูกท าลายและท าความสะอาด (destroy) 

โดย Servlet Container จะควบคุมและเรยีกเมธอดเหล่านี้ใหต้ามล าดบั 

 
รายละเอียดเมธอดหลกัใน Servlet Lifecycle 

เมธอด ความหมาย การเรียกใช้โดย 
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เมธอด ความหมาย การเรียกใช้โดย 

init() เรยีกครัง้เดยีวตอนสรา้ง Servlet เพื่อเตรยีมการตัง้ค่าเริม่ตน้ 
Servlet 
Container 

service() เรยีกทุกครัง้เมื่อม ีHTTP Request เขา้มา เพื่อประมวลผลและตอบสนอง 
Servlet 
Container 

destroy() 
เรยีกครัง้เดยีวก่อน Servlet ถูกลบออกจากหน่วยความจ า เพื่อเคลยีร ์
resource 

Servlet 
Container 

 
การท างานแต่ละเมธอด 
1. init() 

 เรยีกครัง้แรกตอน Servlet ถูกโหลดเขา้หน่วยความจ า 
 ใชส้ าหรบัเตรยีมตวั เช่น โหลดขอ้มลู config, สรา้ง connection pool 
 ถ้า override ตอ้งเรยีก super.init() ดว้ย 

2. service(HttpServletRequest request, HttpServletResponse response) 
 รบั Request ทุกตวัทีเ่ขา้มา 
 คอยตรวจสอบ HTTP method (GET, POST, PUT, DELETE) 
 เรยีกเมธอดยอ่ย เช่น doGet(), doPost() ตาม method ของ HTTP request 

3. destroy() 
 เรยีกก่อน Servlet ถูกยกเลกิ เช่น Server ปิด, Redeploy แอป 
 ใชส้ าหรบัปิด resource ทีเ่ปิดไว ้เช่น ปิด connection, ลา้ง cache 

 
ตวัอย่าง Servlet แสดง Lifecycle Logs 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
import java.io.IOException; 
 
@WebServlet("/lifecycle") 
public class LifecycleServlet extends HttpServlet { 
 
    @Override 



ศูนยห์นงัสือราคานกัเรียน 

 

Java Servlet Web Programming หนา้ 33 

 

    public void init() throws ServletException { 
        super.init(); 
        System.out.println("Servlet is initializing..."); 
    } 
 
    @Override 
    protected void service(HttpServletRequest req, HttpServletResponse resp) throws 
ServletException, IOException { 
        System.out.println("Service method called..."); 
        super.service(req, resp); // ใหเ้รยีก doGet/doPost ต่อไป 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
ServletException, IOException { 
        System.out.println("Handling GET request..."); 
        resp.getWriter().println("Hello from doGet()"); 
    } 
 
    @Override 
    protected void doPost(HttpServletRequest req, HttpServletResponse resp) throws 
ServletException, IOException { 
        System.out.println("Handling POST request..."); 
        resp.getWriter().println("Hello from doPost()"); 
    } 
 
    @Override 
    public void destroy() { 
        System.out.println("Servlet is being destroyed..."); 
        super.destroy(); 
    } 
} 

 
การทดสอบ 
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1. เมื่อโหลด Servlet ตวันี้คร ัง้แรก (เช่น เปิด URL /lifecycle) 
 Console log จะเหน็ขอ้ความ "Servlet is initializing..." แสดงวา่ init() ถูกเรยีก 
 หลงัจากนัน้ "Service method called..." ตามดว้ย "Handling GET request..." (ถ้าใช ้GET) 
 Browser จะเหน็ขอ้ความ Hello from doGet() 
2. เมื่อส่ง HTTP POST ไปที ่URL เดยีวกนั 
 Log จะเหน็ "Service method called..." และ "Handling POST request..." 
 Browser ไดข้อ้ความ Hello from doPost() 
3. เมื่อ Server ปิดหรอื Redeploy 
 Log จะเหน็ "Servlet is being destroyed..." แสดงวา่ destroy() ถูกเรยีก 

 
สรปุ 

 init() เรยีกแค่ครัง้แรกตอน Servlet โหลด 
 service() เรยีกทุก Request เพื่อแยก HTTP Method ไปท างานต่อ 
 destroy() เรยีกก่อน Servlet หยดุท างาน เพื่อเคลยีร ์resource 

 
ตวัอยา่ง Servlet ทีเ่น้นแสดงการท างานของ Servlet Lifecycle (init, service, destroy) พรอ้มฟีเจอร์
ทีต่่างกนั 5 ตวัอยา่ง เพื่อใหเ้หน็ภาพและเขา้ใจลกึขึน้ 

 
ตวัอย่าง 1: Lifecycle กบัการเกบ็จ านวนผู้เข้าชม (Visitor Counter) 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
import java.io.IOException; 
 
@WebServlet("/visitor") 
public class VisitorCounterServlet extends HttpServlet { 
    private int visitorCount; 
 
    @Override 
    public void init() throws ServletException { 
        visitorCount = 0; // เริม่นบั 0 
        System.out.println("Servlet initialized: visitorCount set to 0"); 
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    } 
 
    @Override 
    protected void service(HttpServletRequest req, HttpServletResponse resp) throws 
ServletException, IOException { 
        visitorCount++; 
        System.out.println("Visitor count incremented: " + visitorCount); 
        super.service(req, resp); 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
ServletException, IOException { 
        resp.setContentType("text/plain"); 
        resp.getWriter().println("Visitor Count: " + visitorCount); 
    } 
 
    @Override 
    public void destroy() { 
        System.out.println("Servlet destroyed. Final visitor count: " + visitorCount); 
    } 
} 

 
ตวัอย่าง 2: Lifecycle กบั Resource Initialization (เช่น Database Connection) 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
import java.io.IOException; 
import java.sql.Connection; 
import java.sql.DriverManager; 
import java.sql.SQLException; 
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@WebServlet("/dbtest") 
public class DatabaseServlet extends HttpServlet { 
    private Connection conn; 
 
    @Override 
    public void init() throws ServletException { 
        try { 
            Class.forName("com.mysql.cj.jdbc.Driver"); 
            conn = DriverManager.getConnection("jdbc:mysql://localhost:3306/mydb", "user", 
"pass"); 
            System.out.println("Database connection established."); 
        } catch (ClassNotFoundException | SQLException e) { 
            throw new ServletException("DB connection failed", e); 
        } 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        resp.setContentType("text/plain"); 
        if (conn != null) { 
            resp.getWriter().println("Database connection is ready."); 
        } else { 
            resp.getWriter().println("No database connection."); 
        } 
    } 
 
    @Override 
    public void destroy() { 
        try { 
            if (conn != null && !conn.isClosed()) { 
                conn.close(); 
                System.out.println("Database connection closed."); 
            } 
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        } catch (SQLException e) { 
            e.printStackTrace(); 
        } 
    } 
} 

 
ตวัอย่าง 3: Lifecycle กบั Logging Request IP Address 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
import java.io.IOException; 
 
@WebServlet("/logip") 
public class LogIPServlet extends HttpServlet { 
 
    @Override 
    public void init() throws ServletException { 
        System.out.println("LogIPServlet initialized"); 
    } 
 
    @Override 
    protected void service(HttpServletRequest req, HttpServletResponse resp) throws 
ServletException, IOException { 
        String ip = req.getRemoteAddr(); 
        System.out.println("Request from IP: " + ip); 
        super.service(req, resp); 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        resp.getWriter().println("Your IP has been logged."); 
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    } 
 
    @Override 
    public void destroy() { 
        System.out.println("LogIPServlet destroyed"); 
    } 
} 

 
ตวัอย่าง 4: Lifecycle กบันับจ านวน Request แยกตาม Method (GET, POST) 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
import java.io.IOException; 
 
@WebServlet("/methodcount") 
public class MethodCountServlet extends HttpServlet { 
    private int getCount; 
    private int postCount; 
 
    @Override 
    public void init() throws ServletException { 
        getCount = 0; 
        postCount = 0; 
        System.out.println("MethodCountServlet initialized"); 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        getCount++; 
        resp.getWriter().println("GET requests: " + getCount); 
    } 
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    @Override 
    protected void doPost(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        postCount++; 
        resp.getWriter().println("POST requests: " + postCount); 
    } 
 
    @Override 
    public void destroy() { 
        System.out.println("MethodCountServlet destroyed"); 
        System.out.println("Total GET: " + getCount); 
        System.out.println("Total POST: " + postCount); 
    } 
} 

 
ตวัอย่าง 5: Lifecycle กบัแสดงเวลาท่ี Servlet ถกูสร้างและถกูท าลาย 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
import java.io.IOException; 
import java.time.LocalDateTime; 
 
@WebServlet("/timeservlet") 
public class TimeServlet extends HttpServlet { 
    private LocalDateTime initTime; 
 
    @Override 
    public void init() throws ServletException { 
        initTime = LocalDateTime.now(); 
        System.out.println("Servlet initialized at: " + initTime); 
    } 
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    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        LocalDateTime now = LocalDateTime.now(); 
        resp.getWriter().println("Servlet was initialized at: " + initTime); 
        resp.getWriter().println("Current time: " + now); 
    } 
 
    @Override 
    public void destroy() { 
        LocalDateTime destroyTime = LocalDateTime.now(); 
        System.out.println("Servlet destroyed at: " + destroyTime); 
    } 
} 

 
ตวัอยา่ง Servlet ทีม่กีารส่งขอ้มลูกลบัเป็น HTML พรอ้มโคด้เตม็ ๆ พรอ้มอธบิายประกอบใหเ้ขา้ใจง่าย 

 
ตวัอย่าง 1: VisitorCounterServlet แสดงจ านวนผู้เข้าชมในรปูแบบ HTML 
package com.example.servlet; 
 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
 
import java.io.IOException; 
import java.io.PrintWriter; 
 
@WebServlet("/visitor") 
public class VisitorCounterServlet extends HttpServlet { 
    private int visitorCount; 
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    @Override 
    public void init() throws ServletException { 
        visitorCount = 0; 
    } 
 
    @Override 
    protected void service(HttpServletRequest req, HttpServletResponse resp) throws 
ServletException, IOException { 
        visitorCount++; 
        super.service(req, resp); // เรยีก doGet หรอื doPost ตาม method 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        resp.setContentType("text/html;charset=UTF-8"); 
 
        try (PrintWriter out = resp.getWriter()) { 
            out.println("<!DOCTYPE html>"); 
            out.println("<html><head><title>Visitor Counter</title></head><body>"); 
            out.println("<h1>Welcome to Our Website!</h1>"); 
            out.println("<p>You are visitor number: <strong>" + visitorCount + "</strong></p>"); 
            out.println("</body></html>"); 
        } 
    } 
} 

 
ตวัอย่าง 2: TimeServlet แสดงเวลาท่ี Servlet เร่ิมท างานและเวลาปัจจบุนัใน HTML 
package com.example.servlet; 
 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
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import jakarta.servlet.http.HttpServletResponse; 
 
import java.io.IOException; 
import java.io.PrintWriter; 
import java.time.LocalDateTime; 
import java.time.format.DateTimeFormatter; 
 
@WebServlet("/time") 
public class TimeServlet extends HttpServlet { 
    private LocalDateTime initTime; 
 
    @Override 
    public void init() throws ServletException { 
        initTime = LocalDateTime.now(); 
    } 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        resp.setContentType("text/html;charset=UTF-8"); 
        LocalDateTime now = LocalDateTime.now(); 
        DateTimeFormatter formatter = DateTimeFormatter.ofPattern("yyyy-MM-dd HH:mm:ss"); 
 
        try (PrintWriter out = resp.getWriter()) { 
            out.println("<!DOCTYPE html>"); 
            out.println("<html><head><title>Time Servlet</title></head><body>"); 
            out.println("<h2>Servlet Initialized at: " + initTime.format(formatter) + "</h2>"); 
            out.println("<h2>Current Time: " + now.format(formatter) + "</h2>"); 
            out.println("</body></html>"); 
        } 
    } 
} 

 
ตวัอย่าง 3: ParameterEchoServlet รบัพารามิเตอรจ์าก URL แล้วแสดงผลใน HTML 
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package com.example.servlet; 
 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
 
import java.io.IOException; 
import java.io.PrintWriter; 
 
@WebServlet("/echo") 
public class ParameterEchoServlet extends HttpServlet { 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        String name = req.getParameter("name"); 
        if (name == null || name.isEmpty()) { 
            name = "Guest"; 
        } 
 
        resp.setContentType("text/html;charset=UTF-8"); 
 
        try (PrintWriter out = resp.getWriter()) { 
            out.println("<!DOCTYPE html>"); 
            out.println("<html><head><title>Parameter Echo</title></head><body>"); 
            out.println("<h1>Hello, " + escapeHtml(name) + "!</h1>"); 
            out.println("<p>Try passing your name in the URL like ?name=John</p>"); 
            out.println("</body></html>"); 
        } 
    } 
 
    // ฟังกช์นัช่วยป้องกนั XSS เบือ้งตน้ 
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    private String escapeHtml(String input) { 
        return input.replaceAll("&", "&amp;") 
                    .replaceAll("<", "&lt;") 
                    .replaceAll(">", "&gt;") 
                    .replaceAll("\"", "&quot;") 
                    .replaceAll("'", "&#x27;"); 
    } 
} 

 
ตวัอย่าง 4: FormServlet แสดงฟอรม์ HTML และรบัข้อมลู POST 
package com.example.servlet; 
 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
 
import java.io.IOException; 
import java.io.PrintWriter; 
 
@WebServlet("/form") 
public class FormServlet extends HttpServlet { 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        resp.setContentType("text/html;charset=UTF-8"); 
 
        try (PrintWriter out = resp.getWriter()) { 
            out.println("<!DOCTYPE html>"); 
            out.println("<html><head><title>Input Form</title></head><body>"); 
            out.println("<h1>Submit Your Name</h1>"); 
            out.println("<form method='post' action='form'>"); 
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            out.println("Name: <input type='text' name='username' />"); 
            out.println("<input type='submit' value='Submit' />"); 
            out.println("</form>"); 
            out.println("</body></html>"); 
        } 
    } 
 
    @Override 
    protected void doPost(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        String username = req.getParameter("username"); 
        if (username == null || username.isEmpty()) { 
            username = "Unknown"; 
        } 
 
        resp.setContentType("text/html;charset=UTF-8"); 
        try (PrintWriter out = resp.getWriter()) { 
            out.println("<!DOCTYPE html>"); 
            out.println("<html><head><title>Form Result</title></head><body>"); 
            out.println("<h1>Thank you, " + escapeHtml(username) + "!</h1>"); 
            out.println("<a href='form'>Back to form</a>"); 
            out.println("</body></html>"); 
        } 
    } 
 
    private String escapeHtml(String input) { 
        return input.replaceAll("&", "&amp;") 
                    .replaceAll("<", "&lt;") 
                    .replaceAll(">", "&gt;") 
                    .replaceAll("\"", "&quot;") 
                    .replaceAll("'", "&#x27;"); 
    } 
} 
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ตวัอย่าง 5: HeaderServlet แสดง HTTP Headers ของค าขอในรปูแบบ HTML 
package com.example.servlet; 
 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
 
import java.io.IOException; 
import java.io.PrintWriter; 
import java.util.Enumeration; 
 
@WebServlet("/headers") 
public class HeaderServlet extends HttpServlet { 
 
    @Override 
    protected void doGet(HttpServletRequest req, HttpServletResponse resp) throws 
IOException { 
        resp.setContentType("text/html;charset=UTF-8"); 
 
        try (PrintWriter out = resp.getWriter()) { 
            out.println("<!DOCTYPE html>"); 
            out.println("<html><head><title>Request Headers</title></head><body>"); 
            out.println("<h1>HTTP Request Headers</h1>"); 
            out.println("<table border='1'>"); 
            out.println("<tr><th>Header Name</th><th>Header Value</th></tr>"); 
 
            Enumeration<String> headerNames = req.getHeaderNames(); 
            while (headerNames.hasMoreElements()) { 
                String name = headerNames.nextElement(); 
                String value = req.getHeader(name); 
                out.println("<tr><td>" + escapeHtml(name) + "</td><td>" + escapeHtml(value) + 
"</td></tr>"); 
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            } 
 
            out.println("</table>"); 
            out.println("</body></html>"); 
        } 
    } 
 
    private String escapeHtml(String input) { 
        return input.replaceAll("&", "&amp;") 
                    .replaceAll("<", "&lt;") 
                    .replaceAll(">", "&gt;") 
                    .replaceAll("\"", "&quot;") 
                    .replaceAll("'", "&#x27;"); 
    } 
} 

 
วิธีทดสอบ 

 Deploy Servlet เหล่านี้บน Tomcat หรอื GlassFish 
 เขา้ URL เช่น http://localhost:8080/yourApp/visitor หรอื /time หรอื /echo?name=ChatGPT 

เป็นตน้ 

 
การส่งพารามิเตอรผ์า่น URL 

 
การส่งพารามิเตอรผ่์าน URL คืออะไร? 
การส่งพารามเิตอรผ์่าน URL คอืการแนบขอ้มลูทีเ่ราตอ้งการส่งไปยงั Servlet ลงไปใน URL โดยใช้
รปูแบบ 
http://server/context-path/servlet-path?key1=value1&key2=value2 
ขอ้มลูหลงัเครื่องหมาย ? คอืพารามเิตอร ์ทีม่รีปูแบบเป็นคู่ key=value และแต่ละคู่จะแยกกนัดว้ย
เครื่องหมาย & 

 
วิธีดึงพารามิเตอรใ์น Servlet ด้วย request.getParameter() 
ในฝัง่ Servlet เราสามารถดงึค่าพารามเิตอรท์ีส่่งมาจาก URL ไดด้ว้ย 
String value = request.getParameter("key"); 
โดย key คอืชื่อพารามเิตอรท์ีส่่งมาใน URL 

http://localhost:8080/yourApp/visitor
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ตวัอย่างการส่งพารามิเตอรผ่์าน URL 
1. ตวัอย่าง HTML ส่งพารามิเตอรผ่์านลิงก ์
<!DOCTYPE html> 
<html> 
<head> 
    <title>Send Parameter via URL</title> 
</head> 
<body> 
    <h1>Send Parameter via URL Example</h1> 
    <a href="hello?name=John">Say Hello to John</a> 
</body> 
</html> 
เมื่อคลกิลงิกน์ี้ Browser จะส่ง HTTP GET ไปที ่URL /hello?name=John 

 
2. ตวัอย่าง Servlet รบัพารามิเตอรแ์ละแสดงผล 
import java.io.IOException; 
import java.io.PrintWriter; 
 
import jakarta.servlet.ServletException; 
import jakarta.servlet.annotation.WebServlet; 
import jakarta.servlet.http.HttpServlet; 
import jakarta.servlet.http.HttpServletRequest; 
import jakarta.servlet.http.HttpServletResponse; 
 
@WebServlet("/hello") 
public class HelloServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response)  
            throws ServletException, IOException { 
 
        // ดงึพารามเิตอรช์ื่อ "name" จาก URL 
        String name = request.getParameter("name"); 
         
        response.setContentType("text/html;charset=UTF-8"); 
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        PrintWriter out = response.getWriter(); 
 
        out.println("<html><body>"); 
        if (name != null && !name.isEmpty()) { 
            out.println("<h1>Hello, " + name + "!</h1>"); 
        } else { 
            out.println("<h1>Hello, Guest!</h1>"); 
        } 
        out.println("</body></html>"); 
    } 
} 

 Servlet นี้รบัค าขอแบบ GET 
 ดงึค่าพารามเิตอรช์ื่อ name จาก URL 
 แสดงขอ้ความทกัทายโดยใชค้่าทีร่บัมา 

 
3. ตวัอย่าง URL ท่ีเรียก Servlet 
http://localhost:8080/YourApp/hello?name=Alice 
ผลลพัธท์ีแ่สดงในเวบ็เบราวเ์ซอรค์อื 
Hello, Alice! 

 
4. ตวัอย่างการใช้ฟอรม์ HTML ส่งพารามิเตอร ์(GET method) 
<!DOCTYPE html> 
<html> 
<head> 
    <title>Send Parameter via Form</title> 
</head> 
<body> 
    <h1>Send Parameter via Form</h1> 
    <form action="hello" method="get"> 
        Enter your name: <input type="text" name="name" /> 
        <input type="submit" value="Say Hello" /> 
    </form> 
</body> 
</html> 



ศูนยห์นงัสือราคานกัเรียน 

 

Java Servlet Web Programming หนา้ 50 

 

 เมื่อกรอกชื่อแลว้กด Submit จะส่งค่าชื่อไปที ่/hello?name=xxx 
 Servlet จะรบัค่าพารามเิตอรแ์ลว้แสดงผลเหมอืนตวัอยา่งก่อนหน้า 

 
สรปุ 

ขัน้ตอน รายละเอียด 

ส่งพารามเิตอรผ์่าน URL แนบขอ้มลูหลงัเครื่องหมาย ? ใน URL 

ดงึพารามเิตอรใ์น Servlet ใช ้request.getParameter("key") 

ตวัอยา่งการใชง้าน ส่งลงิก ์หรอื ฟอรม์ HTML ทีม่พีารามเิตอร ์

 
ตวัอยา่งเพิม่เตมิของการส่งพารามเิตอรผ์่าน URL และการใชง้าน request.getParameter() ในหลาย
รปูแบบ 

 
ตวัอย่าง 1: ส่งพารามิเตอรห์ลายตวัผ่าน URL 
URL ตวัอย่าง 
http://localhost:8080/YourApp/user?name=Mark&age=25&city=Bangkok 
Servlet รบัพารามิเตอรห์ลายตวั 
@WebServlet("/user") 
public class UserServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response)  
            throws ServletException, IOException { 
        String name = request.getParameter("name"); 
        String age = request.getParameter("age"); 
        String city = request.getParameter("city"); 
 
        response.setContentType("text/html;charset=UTF-8"); 
        PrintWriter out = response.getWriter(); 
 
        out.println("<html><body>"); 
        out.println("<h2>User Info</h2>"); 
        out.println("<p>Name: " + name + "</p>"); 
        out.println("<p>Age: " + age + "</p>"); 
        out.println("<p>City: " + city + "</p>"); 
        out.println("</body></html>"); 



ศูนยห์นงัสือราคานกัเรียน 

 

Java Servlet Web Programming หนา้ 51 

 

    } 
} 

 
ตวัอย่าง 2: ส่งพารามิเตอรจ์ากฟอรม์ HTML แบบ POST 
HTML ฟอรม์ 
<!DOCTYPE html> 
<html> 
<head> 
    <title>POST Form Example</title> 
</head> 
<body> 
    <form action="submit" method="post"> 
        Username: <input type="text" name="username" /><br/> 
        Password: <input type="password" name="password" /><br/> 
        <input type="submit" value="Login" /> 
    </form> 
</body> 
</html> 
Servlet รบัพารามิเตอร ์POST 
@WebServlet("/submit") 
public class SubmitServlet extends HttpServlet { 
    protected void doPost(HttpServletRequest request, HttpServletResponse response)  
            throws ServletException, IOException { 
        String username = request.getParameter("username"); 
        String password = request.getParameter("password"); 
 
        response.setContentType("text/html;charset=UTF-8"); 
        PrintWriter out = response.getWriter(); 
 
        out.println("<html><body>"); 
        out.println("<h2>Login Info</h2>"); 
        out.println("<p>Username: " + username + "</p>"); 
        out.println("<p>Password: " + password + "</p>"); 
        out.println("</body></html>"); 
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    } 
} 

 
ตวัอย่าง 3: ตรวจสอบพารามิเตอรว่์าเป็นค่าว่างหรือไม่ 
@WebServlet("/check") 
public class CheckParamServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response)  
            throws ServletException, IOException { 
        String param = request.getParameter("data"); 
 
        response.setContentType("text/html;charset=UTF-8"); 
        PrintWriter out = response.getWriter(); 
 
        out.println("<html><body>"); 
        if (param == null || param.trim().isEmpty()) { 
            out.println("<p>No data was provided.</p>"); 
        } else { 
            out.println("<p>Received data: " + param + "</p>"); 
        } 
        out.println("</body></html>"); 
    } 
} 

 
ตวัอย่าง 4: ส่งพารามิเตอรใ์น URL และส่งกลบัเป็น JSON 
@WebServlet("/json") 
public class JsonServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response)  
            throws ServletException, IOException { 
        String name = request.getParameter("name"); 
        if (name == null) name = "Guest"; 
 
        response.setContentType("application/json;charset=UTF-8"); 
        PrintWriter out = response.getWriter(); 
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        String json = String.format("{\"message\": \"Hello, %s!\"}", name); 
        out.print(json); 
    } 
} 

 
ตวัอย่าง 5: ส่งพารามิเตอรห์ลายค่าซ า้กนั (Multiple Values) 
บางครัง้เราสง่พารามเิตอรท์ีม่ชี ื่อเดยีวกนัแต่มคี่าหลายคา่ เช่น 
http://localhost:8080/YourApp/colors?color=red&color=green&color=blue 
ใน Servlet เราใช ้
String[] colors = request.getParameterValues("color"); 
ตวัอย่าง Servlet 
@WebServlet("/colors") 
public class ColorsServlet extends HttpServlet { 
    protected void doGet(HttpServletRequest request, HttpServletResponse response)  
            throws ServletException, IOException { 
        String[] colors = request.getParameterValues("color"); 
 
        response.setContentType("text/html;charset=UTF-8"); 
        PrintWriter out = response.getWriter(); 
 
        out.println("<html><body>"); 
        if (colors != null) { 
            out.println("<h3>Selected Colors:</h3><ul>"); 
            for (String color : colors) { 
                out.println("<li>" + color + "</li>"); 
            } 
            out.println("</ul>"); 
        } else { 
            out.println("<p>No colors selected.</p>"); 
        } 
        out.println("</body></html>"); 
    } 
} 
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สรปุ 

การท างานของเวบ็แอปพลเิคชนัทีพ่ฒันาดว้ย Java Servlet พื้นฐานส าคญัอยู่ที่การสื่อสารผ่าน
โปรโตคอล HTTP โดยใช้คลาส HttpServletRequest และ HttpServletResponse ในการรบัและ
ตอบสนองค าขอจากผูใ้ช ้HttpServletRequest ช่วยใหส้ามารถดงึขอ้มลูทีผู่ใ้ชส้่งเขา้มา เช่น พารามเิตอร์
ในแบบฟอรม์หรอื URL ขณะที ่HttpServletResponse ท าหน้าทีจ่ดัเตรยีมขอ้มลูตอบกลบักลบัไปยงัผูใ้ช ้
เช่น ขอ้ความ HTML หรอืผลลพัธ์จากการประมวลผล การเขา้ใจการใช้คลาสทัง้สองนี้อย่างถูกต้องจงึ
เป็นรากฐานของการพฒันาแอปพลเิคชนัทีต่อบสนองไดอ้ยา่งมปีระสทิธภิาพ 

นอกจากนี้ การเขา้ใจวงจรชวีติของ Servlet (Servlet Lifecycle) ซึ่งประกอบด้วยเมธอด init(), 
service() และ destroy() จะช่วยให้สามารถควบคุมการท างานของ Servlet ตัง้แต่เริม่ต้นจนสิ้นสุดได้
อย่างมปีระสทิธิผล โดย init() ใช้ส าหรบัเตรยีมความพร้อมก่อนเริ่มให้บริการ service() ท าหน้าที่
ประมวลผลค าขอทุกครัง้ที่มีผู้ใช้งาน และ destroy() จะถูกเรียกเมื่อ Servlet ถูกน าออกจาก
หน่วยความจ า ทัง้นี้ยงัมกีารส่งขอ้มูลระหว่างผู้ใช้และแอปพลเิคชนัผ่านพารามเิตอร์ URL ซึ่งสามารถ
เข้าถึงได้โดยใช้ request.getParameter() เพื่อรบัข้อมูลและน าไปใช้ในการประมวลผลค าขอในฝัง่
เซริฟ์เวอรอ์ยา่งเหมาะสม 
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